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Google Sheets - Advanced
 

Class Objectives 

 Inserting notes/comments into a cell  

 Inserting a text box  

 Conditional formatting  

 IF function  

 Protecting worksheet data  

 Hiding/unhiding a column or row  

 Referencing cells in multiple worksheets  
 

 Relative/absolute/mixed addressing  

 Pie Charts and Line Charts 

 Chart Tools 

 Parsing/Concatenating data 

 Filtering data 

 VLOOKUP 

 PivotTables 
 

Note: Google Sheets will often have several ways to do a task. There might be one option under the 

menus, another option on the toolbar, another available with a right-click, and also a keyboard shortcut. 

Use whatever method works for you. If you forget where to find a command, you can perform a search 

under the Help menu. 

Inserting Notes into a Cell 

Inserting a note is like attaching a Post-It note to a specific cell. A little black triangle will appear in the 

corner of the cell to let you know it has a note. Hovering over the cell will display the note. 

To insert a note: 

1. Select the cell to which you’d like to 

add a note. 

2. Choose Insert from the menu, then 

select Note. 

To delete a note: 

1. Right-click on the cell. 

2. Select Delete Notes from the menu.  

Inserting Comments into a Cell 

A comment is similar to a note, but it will have your name and a timestamp attached. If you’re 

collaborating with someone, you can hold a conversion about the comment you’ve left. If you’ve 

resolved the issue the comment was addressing, you can mark it resolved and hide it. You can see a cell 

has a comment by the orange marker in its corner. 

To insert a comment: 

1. Select the cell you’d like to comment on. 

2. Choose Insert from the menu, then select Comment. 

To resolve a comment: 

1. Select the cell so the comment box is visible. 
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2. Click on the green checkmark. 

To delete a comment: 

1. Click on the cell so the comment box is 

visible. 

2. Click on the three dots. 

3. Choose Delete. 

 

Inserting a Text Box  

If you’d like to make a note that’s always visible, you can use a text box. You have control over the font 

and color and you can change the size of these text boxes and move them around to reposition them. 

To insert a text box: 

1. Choose Insert, then Drawing. 
2. From the drawing popup, click on the Text box icon on the toolbar.  
3. Position the cross-shaped cursor onto the checkered space below and click and drag your cursor to 

create a text box. 
4. Type in the text you’d like to add. 
5. Customize it with the options on the toolbar. 
6. When you’re done, click Save and Close in the upper-right corner of the drawing popup. 
7. To position the textbox, click on it when the hand icon is showing and drag it. Resize with the 

controls on the borders of the box. 

 

Conditional Formatting  

You can use conditional formatting to apply a style to a cell based on the cell’s value. 

 

To apply conditional formatting: 

1. Select the cell(s) to which you’d like to apply conditional formatting. 
2. Select Format, then Conditional formatting. 
3. Select the desired type of rule (for example: Greater than and then the 

value or other information). 
4. Choose the Formatting style you want, such as bold or a different color. 
5. Click Done.  
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IF function 

Using the IF statement in a formula allows you to create logically determined results. An IF statement 

could look something like this: =IF(B2<50,1,0). This translates into: IF the content of B2 is less than 50, 

then put a 1 in the cell which has the IF formula. IF the content of B3 is not less than 50, then put a 0 in 

the cell which has the IF formula. 

In this example, the above formula is 

entered into cell C2. If the value in cell 

B2 is less than 50, then the number 1 

will be entered in cell C2. If not, the 

number 0 will be entered in cell C2. 

 

 

Protecting Sheet Data 

If other users will be accessing your sheet, you may want to prevent them from modifying the contents 

of some cells while allowing them to enter data into other cells. To do this, you can protect ranges and 

sheets, allowing access to some cells but not others.   

Protecting cells: 

1. Right-click on a cell or highlight a range of cells you want to protect 
and right-click on the range. 

2. Select View more cell options and select Protect range.  
 

Protecting a sheet: 
Right-click on a sheet you want to protect and select Protect sheet.  

-OR- 
Go to Data->Protect Sheets & Ranges 

1. The Protected sheets & ranges box will appear on the right. Click + 
Add a sheet or range. 

2. This box has a Range tab and a Sheet tab. Make your selection. 
3. Click Set Permissions. 
4. Choose who can edit the cells, then click Done. 

 
Note: The Enter a description box is optional, but if you’re protecting 
several ranges, a description can help you manage them. 
 
Unprotecting cells: 
Open the Protect sheets and ranges box. 
1. Click Cancel so you can see a list of protected ranges. 

2. Click on the one you want to remove. 

3. Click on the trash can icon. 

4. It will ask you to confirm. Click Remove. 
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Hiding and Unhiding a Column or Row 

Sometimes a row or column is outdated or cluttering up your view, yet you still might want the 

information later. In that case, you can temporarily hide the row or column. Unlike in Excel, hiding data 

does NOT prevent other people from viewing it. Even someone with only View access and not Edit 

access can Make a Copy and then Unhide the row or column in the copy. Don’t share sheets with 

sensitive information in them to people who should not have access to that information. 

Hiding columns and rows does not affect calculations in a worksheet; all data in hidden columns and 

rows is still referenced by formulas as necessary. Hidden columns and rows do not appear in a printout 

either.  

How to hide a column or row: 

1. Select the column or row you want to hide. (You can also select more than one column or row.) 
2. Right-click and select Hide row or Hide column. 

 
How to unhide a column or row: 

1. Click on the arrows between the adjacent rows/columns.  

How to hide a sheet: 

1. Right-click on the tab at the bottom of the sheet that belongs to the sheet you would like to hide. 

2. Select Hide sheet. 

How to unhide a sheet: 

1. Select View and hover over Hidden sheets 

2. Click on the name of the sheets you’d like to be unhidden 

 

Referencing cells in multiple sheets 

The various sheets in a document can be referred in other sheets by including the sheet reference as 

well as the cell address in a formula. A sheet reference includes the sheet name followed by an 

exclamation point, e.g., Sheet2! refers to Sheet 2. To refer to cell A1 on Sheet2 (when working in any 

sheet other than Sheet2), the reference would be Sheet2!A1. 

Notice that the exclamation point separates the sheet reference from the cell address. 

If you have named the sheet, simply use the new sheet name (followed by an exclamation point) and 

the cell address. If the sheet name includes spaces you must surround the sheet name with single 

quotation marks. If you rename a sheet, Google Sheets will update all previous references to the new 

name. 

To refer to cell A1 on a sheet named Budget, the reference would be:   

=Budget!A1 
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To refer to cell A1 on a sheet named Annual Budget, the reference would be: 

=‘Annual Budget’!A1 

How to use a function on data held on multiple sheets: 

1. Click a blank cell that you want the calculated total to be in. 

2. Type a formula that includes references to the source cells on each sheet that contains data you 
want to sum, e.g. =SUM('Worksheet Name'!B13:B23). 

 

Helpful hint: 
To enter a reference in a formula with less typing, enter the formula up to the point where you need to 
reference cells from another worksheet. If the cell/s is/are on another sheet, first click that sheet’s tab, 
and then click the cell/s you’d like to be used in the formula. Press the Enter key. 
 

Relative/Absolute/Mixed Addressing 

Calling cells by just their column and row labels (such as "A1") is called relative referencing. When a 

formula contains relative referencing and it is copied from one cell to another, Sheets does not create 

an exact copy of the formula. It will change cell addresses relative to the row and column they are 

moved to. For example, if a simple addition formula in cell C1 "=(A1+B1)" is copied to cell C2, the 

formula would change to "=(A2+B2)" to reflect the new row. 

To prevent this change, cells must be called by absolute referencing. This is accomplished by placing 

dollar signs "$" within the cell addresses in the formula. Continuing the previous example, the formula in 

cell C1 would read "=($A$1+$B$1)".  If this formula is copied, it will always yield the sum of cells A1 and 

B1, even if it is copied into C2. Both the column and row of both cells are absolute and will not change 

when copied. 

Mixed referencing can be used where only the row OR column is fixed. For example, in the formula 

"=(A$1+$B2)", the row of cell A1 is fixed and the column of cell B2 is fixed. 

 

Charting with Pie Charts 

Data for a chart doesn’t have to exist all in one block. You can use CTRL+click to select non-adjacent 

cells. If you select values and their respective labels, you will create a legend within the chart box which 

is generated. If you only select values, your pieces of the pie will not be labeled.   

1. Highlight the values and labels you wish to use to create a pie chart. 
2. Click Insert, then Chart. The Chart Editor box appears. It has two tabs, Setup and Customize. On the 

Setup tab, set your Chart type to Pie chart. 
3. Use the Setup tab to control what data is shown in the chart. Use the Customize tab to change its 

appearance. 
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o Explode the pie by changing Distance from 
center under Pie slice. 

o Use Legend to control where the labels for the 
different slices go. 
 

You can copy and paste your chart into Google Docs. When 
doing this you can choose to link the two files dynamically 
(which would mean that updates to your sheet would 
automatically update the document to which it links), or 
you can simply paste the chart unlinked.  
 
Charting multiple columns with Line Charts: 

You can look at the values contained in multiple columns by charting these columns using a Line graph 

as follows: 

1. Click on the column labels to highlight the columns you’d like to chart.  
2. Select Insert, then Chart, then select a Line chart from the Chart type list.   

 
You can remove any of the charted lines under Series on the Setup tab. Click on the three dots next to 

the column you want to move and select Remove. 

To use the Chart editor to make any other changes, click on the chart and then select one of the 

following: 

 Setup – change chart type or included data.  

 Customize – change the color, font, and other display options.  
 
You can also change objects on the chart by double-clicking on the object. This will pull up the 
appropriate section in the Chart editor to change that object. 
 

Parsing and Concatenating  

Parsing data is taking the contents of one cell and splitting it between two or more other cells. An 

example of this would be taking a cell which contains the first and last name of a person and splitting 

that information between two cells. The end result is one cell with the person’s first name and another 

cell with the person’s last name. 

1. Highlight the column containing the original text. 
2. Click Data, then select Split text to columns. 
3. A Separator box will appear at the bottom. It will guess what 

character separates your data (such as a comma in Lastname, 
Firstname). 

4. Change the Separator if necessary. 
  

Concatenating cells joins the information contained in two cells together to make one cell. 

1. Select the cell that will contain the result. 
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2. Under the Functions icon on the toolbar, select CONCATENATE. Its most easily found under the Text 
menu. 

3. Enter the cells you want to join together, with a separator between them if desired. For example, for 
joining two names, you might do =CONCATENATE(C2," ",B2). 

 

Filtering data 

Filtering is a quick and easy way to find and work with a subset of data. A filter displays only the rows 

that meet criteria that you choose. Unlike sorting, filtering does not rearrange a range. Filtering 

temporarily hides rows you do not want displayed. When Sheets filters rows, you can edit, format, chart, 

and print your range subset without rearranging or moving it.  

To create filter buttons at the top of data you’d like to filter: 

1. Click on the column label for the column you wish to filter. 
2. Click on the Create a filter icon in the toolbar  
3. Click on the green striped arrow that appears at the top of the 

column for a drop-down menu in which you can select the 
appropriate color, text or numeric filter,  
e.g.: Filter by condition, then select from the menu 

a. Greater than, less than, in between… 
b. Text starts with, ends with, contains… 

 

VLOOKUP 

VLOOKUP is a function in Sheets which works with lists within a sheet. The list can be for anything – a list 

of employees, products, customers, parts, people, etc. You’ll need to make sure that your list includes a 

column with a unique identifier for each item in the list. The column with the unique identifier needs to 

be in the first column of your source table. With a VLOOKUP you ask Sheets to go to the source table, 

look up a unique identifier, find another piece of data associated with that unique identifier and put the 

piece of data in your target sheet. For example, you could pass VLOOKUP an item code and it would 

return to you the corresponding item’s description, its price, its availability, etc. 

You’ll need a list of items with at least two columns of data. The first column needs to be a unique 

identifier. Store this list on one sheet. On another sheet, enter one of the unique identifiers into a cell.  

Select the cell in which you want the retrieved information about your unique identifier to be placed by 

Sheets. In other words: where do you want the information Sheets looks up to be put? – Go to that cell 

to enter the VLOOKUP function as follows: 

1. Under the Functions icon on the toolbar, select Lookup->VLOOKUP 
2. In the Function enter the following information separated by commas: 

VLOOKUP(search_key, range, index, [is_sorted]). 
 
a. search_key (What unique identifier are you looking up in your list?) e.g. A11 (what’s the value to 

search for in my target table?). 
b. range (Where is your list?) e.g. ‘NameOtherSheet’!A2:D7 (hint: don’t include the header line 

when you select your source table.). 
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c. index (Which column holds the information you want to have Sheets retrieve from your list?) 
e.g. 2 (the second column in my source table). 

d. is_sorted (If the first column of the source list is sorted alphabetically/numerically in ascending 
order, then enter a value of TRUE into this argument, or leave it blank, as it defaults to TRUE. If 
the first column of the source list is not sorted, or it’s sorted in descending order, then you must 
enter a value of FALSE into this argument.) e.g. FALSE. 
 

The result might look something like this: =VLOOKUP(A11,VTable!A2:D7,2,FALSE)  
 
Pivot Tables  

Imagine a spreadsheet of sales figures for your company with hundreds or thousands of rows of data. 

Everyone has questions about what the data means. How do you get the answers? PivotTable reports 

organize and summarize your data, offer comparisons, reveal patterns and relationships, and analyze 

trends. To insert a PivotTable: 

1. Click on the Insert menu then Pivot table. 
2. The Create pivot table pop up window will appear. Under Data range, select the data, and then 

choose whether the table will Insert to a New sheet or the Existing sheet. 
3. From the Pivot table editor on the right-hand side, you can Add what will appear on the PivotTable 

(e.g. Filters, Columns, Rows, Values). 
 
This is the step where most people become frustrated but you just have to start adding until you have 
the view that actually satisfies your needs – there is no right or wrong way of doing this, you can always 
click the Undo button, so experiment until you get a table that meets your specific requirements.  
 

 

This shows the Average Yearly Earnings of employees according to Education (yrs.) and Gender. For this 

PivotTable, we added Yearly Earnings from the Values list. We changed the original Sum of Yearly 

Earnings to Average of Yearly Earnings by selecting AVERAGE from Summarize by instead of SUM. We 

added Education (yrs.) from the Rows list; and Gender from the Columns list. 


